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MẸO VẶT TRONG MS WORD 

 

Khi đang thao tác Word bạn thường gặp nhiều lỗi về font, mất nhiều thời gian để copy tài 
liệu từ trên mạng về, lộ thông tin lưu trong file... Dưới đây là những tình huống thường gặp 
khi dùng word. 
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1. Vẽ một đường thẳng  
Bạn hoàn toàn có thể dễ dàng kẻ một đường thẳng ngang văn bản của mình một cách rất đơn 
giản như sau:  

• Bạn gõ liên tiếp 3 dấu gạch ngang (-) rồi ấn Enter bạn sẽ có một đường kẻ đơn.  
• Bạn gõ liên tiếp 3 dấu gạch dưới (_) rồi ấn Enter bạn sẽ có một đường kẻ đậm  
• Bạn gõ liên tiếp 3 dấu bằng (=) rồi ấn Enter bạn sẽ có một đường kẻ đôi.  

2. Máy tính có sẵn trong Word  
Bạn có biết là bạn hoàn toàn có thể bổ sung thêm một máy tính vào trong Word không? Đúng 
hoàn toàn có thể và sẽ giúp bạn thêm phần thuận lợi trong công việc hơn rất nhiều.  

Trong MS Word vào View | Toolbars | Customize hoặc bạn có thể nhắp chuột phải lên bất kì 
thanh công cụ (toolbar) nào rồi chọn Customize. Trong cửa sổ Customize - bạn đã có cơ hội làm 
quen với cửa sổ này trong phần trước của bài viết - bạn hãy chọn Tools ở bên khung Categories 
bên tay trái và chọn biểu tượng Tool Calculate trong khung Commands bên tay phải. Bạn nhắp 
và giữ chuột trái lên biểu tượng của Tools Calculate rồi kéo và thả lên bất kì thanh công cụ nào 
mà bạn thích.  

Bây giờ bạn có dễ dàng thực hiện các phép tính trong Word bằng cách gõ vào phép tính của rồi 
lựa chọn toàn bộ phép tính, nhắp chuột vào Tools Calculate rồi ấn Ctrl-V để dán kết quả vào.  

3. Status Bar có gì cho bạn? Đánh chữ mà cứ mất dần các chữ bên phải thì tại 
làm sao  
Bạn đã bao giờ để ý đến thanh trạng thái (Status bar) trong Word chưa? Nó cũng có khá nhiều 
điều thú vị đó. Nhưng nếu Word của bạn chưa hề có Status bar thì bạn hãy vào Tools | Options 
chuyển sang mục View. Trong mục này bạn để ý đến phần Show và đánh dấu kiểm vào Status 
bar là xong.  

Thanh trạng thái đúng như tên gọi của nó cho bạn thấy thông tin về văn bản của bạn, thứ tự trang 
hiện thời của bạn, phần, dòng, toạ độ con trỏ chuột... Nhắp đúp chuột lên Số thứ tự của trang, 
bạn sẽ gọi được menu Go to.  

Bên cạnh đó, trên thanh trạng thái bạn còn thấy có REC – TRK – EXT – OVR. Nhắp đúp chuột 
lên bất cứ mục nào bạn sẽ bật tính năng đó lên. Nhắp đúp chuột lên REC, bạn sẽ bật tính năng 
ghi macro – hay còn gọi là thao tác tự động, TRK sẽ giúp bạn theo dõi ghi nhận mọi thay đổi mà 
bạn đã sửa lên văn bản gốc, EXT cho phép bạn có thể lựa chọn văn bản mà chỉ cần dùng phím 
mũi tên lên xuống sang phải sang trái và OVR sẽ bật tính năng ghi đè – tức là mỗi kí tự bạn gõ 
vào sẽ thay thế cho kí tự liền kề nó thay vì xuất hiện ngay bên cạnh.  

4. Tuỳ biến AutoText  
Chắc hẳn là bạn đã để ý thấy nhiều khi Word tự động thay thế và gợi ý giúp bạn những cụm từ 
kiểu như "Best Wishes", “Best regards”… Đây chính là tính năng AutoText của Word. Bạn hoàn 
toàn có thể tự mình tuỳ biến danh sách các từ MS Word tự động thay thế giúp bạn. Bạn hãy vào 
Tools | AutoCorrect Options rồi chuyển sang mục AutoText. Trong cửa sổ AutoText, bạn hãy gõ 
cụm từ mà bạn muốn Word tự động giúp bạn chèn vào mục Enter autotext entries here rồi nhắp 
chuột vào Add. Muốn gỡ bỏ bất cứ autotext nào bạn hãy chọn nó rồi nhắp chuột vào Delete.  



Page 4 of 14 

5. Truy cập nhanh đến các văn bản thường sử dụng  
Cách nhanh nhất và thông dụng nhất để truy cập đến các tệp tin văn bản thường sử dụng trong 
Microsoft Word hiện nay là vào File rồi tìm đến văn bản cần mở ra. Điểm bất lợi của cách này là 
số lượng tệp tin lưu trong danh sách này tương đối hạn chế, cho dù người sử dụng đã vào Tools | 
Options | General để chỉnh thông số “Recent used file list” lên một con số lớn hơn.  

6. Muốn mở văn bản được sử dụng lần cuối cùng thì làm sao cho nhanh 
Để yêu cầu MS Word mỗi lần khởi động đều mở tệp tin văn bản mà bạn sử dụng lần cuối cùng 
trước khi tắt Word bạn hãy thử dùng cách sau đây.  

Bạn hãy tìm đến tệp tin Winword.exe – thông thường tệp tin này có đường dẫn như sau 
C:\Program Files\Microsoft Office và nằm trong thư mục Office 10 đối với phiên bản XP và 
Office 11 với phiên bản 2003. Tìm được, bạn hãy nhắp chuột phải vào tệp tin chọn Send to | 
Desktop (create shortcut).  

Hoặc bạn có thể nhắp chuột phải lên desktop chọn New | Shortcut rồi tìm đến tệp tin 
Winword.exe theo đường dẫn như trên.  

Sau đó bạn ra desktop và nhắp chuột phải vào shortcut vừa tạo ra và chọn Properties. Trong cửa 
sổ Properties, bạn chuyển đến mục Target và gõ “/mFile1” vào cuối cùng đường dẫn trong 
trường này, click OK.  

7. Sử dụng lệnh Paste Special  
Khi bạn copy văn bản trên web hoặc từ các tệp tin Word khác và dán trực tiếp vào Word thì ứng 
dụng sẽ vẫn giữ nguyên định dạng gốc - từ font chữ, màu sắc, bảng biểu… gây phiền phức rất 
nhiều trong việc chỉnh sửa lại những văn bản đó. Để tránh những điều này bạn hãy sử dụng lệnh 
Paste Special. Cách sử dụng như sau:  

Sau khi đã copy văn bản từ nguồn, bạn chuyển vào Word và chọn Edit | Paste Special. Trong cửa 
sổ Paste Special bạn hãy chọn Unformatted Text hoặc Unformatted Unicode Text.  

8. Sắp xếp lại các đoạn nhanh chóng  
Bạn đang muốn sắp xếp lại vị trí các đoạn trong văn bản của mình? Để tránh mất thời gian kéo 
thả hay copy-paste, bạn hãy sử dụng cách sau đây.  

Lựa chọn đoạn văn bản mà bạn muốn thay đổi vị trí lên hoặc xuống, ấn và giữ phím Shift-Alt rồi 
dùng phím mũi tên lên hoặc xuống để điều chỉnh lại vị trí của đoạn văn bản.  

9. Xoá thông tin cá nhân  
Các tệp tin văn bản của MS Word có chứa những thông tin ẩn có thể tiết lộ thông tin về bạn. 
Microsoft cũng đã cho ra công cụ xoá bỏ những thông tin ẩn này Remove Hidden Data trên trang 
web của mình. Tuy nhiên công cụ này hơi khó sử dụng. Vậy để xoá bỏ những thông tin ẩn này 
bạn hãy làm theo cách sau đây.  

Trước khi phổ biến tệp tin văn bản, bạn hãy dùng ứng dụng WordPad (Start | All Programs | 
Accessories) mở văn bản đó ra trước và lưu lại văn bản đó dưới dạng Rich Text Format (.rtf). 
Cuối cùng bạn chỉ việc đổi phần mở rộng của tệp tin văn bản trở lại dạng Word. Lấy ví dụ bạn 
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lưu tệp tin đó thành “test.rtf”, để đổi lại sang dạng Word bạn dùng lệnh rename chuyển lại thành 
“test.doc”.  

10. Định dạng nhanh chóng- Biểu tượng cái chổi sơn thì dùng làm sao?  
Một trong những “viên ngọc ẩn” trong MS Office chính là Format Painter – có hình dáng như 
chiếc chổi sơn trên thanh công cụ chuẩn (Standard toolbar). Nếu chưa có bạn có thể vào Tool | 
Commands, tìm đến mục Format và kéo biểu tượng của công cụ thả vào thanh công cụ chuẩn.  

Khi bạn nhắp chuột vào biểu tượng chiếc chổi sơn, công cụ sẽ copy lại định dạng văn bản tại nơi 
con trỏ chuột xuất hiện. Nếu bạn lựa chọn cả một đoạn (paragraph) hay một ô (cell) rồi mới nhắp 
chuột vào biểu tượng công cụ thì định dạng của đoạn hay ô đó sẽ được sao chép lại. Sau đó bạn 
chỉ cần kéo chuột lựa chọn đoạn văn bản bạn muốn “dán” định dạng giống như đoạn nguồn là 
xong.  

Bằng cách nhắp đúp chuột lên biểu tượng của Format Painter, bạn có thể áp dụng định dạng đã 
được sao chép liên tục cho đến khi bạn ấn phím Esc.  

11. Thêm nhiều lựa chọn hơn  
Nếu bạn giữ nguyên phím Shift sau đó chọn File trong ứng dụng Word hoặc trong cửa sổ soạn e-
mail mới của Outlook, bạn sẽ thấy sự thay đổi trong menu File. Với Word và Outlook bạn sẽ 
thấy có thêm lựa chọn Save All và Close All còn trong Excel bạn sẽ chỉ thấy có Close All.  

12. Xuống dòng không tạo chỉ mục  
Trong một đoạn có chỉ mục nếu bạn muốn xuống dòng mà không muốn dòng đó có chỉ mục thì 
bạn chỉ cần ấn tổ hợp phím Shift-Enter. Lần tới bạn ấn Enter để xuống dòng và tiếp tục theo 
danh sách chỉ mục.  

Riêng trong Excel để xuống dòng trong một ô bạn hãy ấn Alt-Enter.  

13. Các Smart Tags  
Smart Tags - bắt đầu xuất hiện trong phiên bản Microsoft Office XP – chính là những biểu tượng 
ứng dụng công nghệ XML nên có thể xuất hiện ngay lập tức ở trên hoặc ở dưới các dữ liệu phù 
hợp với tính năng của Smart Tags. Để kích hoạt các Smart Tags bạn hãy vào Tools | AutoCorrect 
Options rồi chuyển sang mục Smart Tags và lựa chọn những loại tags mà bạn muốn kích hoạt.  

Lấy ví dụ về Paste Options Smart Tags:  

Paste options: Sau khi bạn dán (paste) dữ liệu trong bất kì ứng dụng Office nào bạn có thể chọn 
Smart Tag (xuất hiện ngay bên cạnh đoạn dữ liệu vừa dán có hình giống như một clipboard) với 
những lựa chọn định dạng phong phú - Match Destination Formatting (chuyển định dạng dữ liệu 
vừa dán giống với định dạng của cả văn bản) và Keep Source Formatting (giữ nguyên định dạng 
của đoạn dữ liệu vừa dán).  

14. Tắt máy tính sau mấy phút là tuỳ ở bạn. Vậy làm thế nào? 
hôm nay đang cần tìm chương trình tự động tắt máy vi tính thì tìm được cái này trên mạng có thể 
có nhiều người đã biết về thủ thuật này hay cũng có người dùng soft để tắt mình chỉ xin giới 
thiệu thêm cho những ai chưa biết giông mình  
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áp dụng đối với Windows XP ta làm như sau:  

• Nhấn Win +R để mở hộp thoại Run  
• Gõ lệnh: shutdown -s -t 30 (Ý nghĩa: shutdown máy sau 30 phút)  

(Ngoài ra:  

shutdown -r -t 40 (restart máy sau 40 phút)  

shutdown -a (thay đổi quyết định không hẹn giờ shutdown nữa)  

...  

cmd để mở hộp thoại command sau đó gõ lệnh: shutdown -? để xem hướng dẫn sử dụng)  

15.  Đổi chữ thường thành chữ hoa và ngược lại 
Thông thường nếu bạn soạn văn bản bằng tiếng Việt thì chuyện đổi chữ thường thành chữ hoa và 
ngược lại là:  

Gõ văn bản bằng chữ thường --> chọn font chữ Việt-hoa để "hô biến" thành chữ hoa và khi 
muốn quay về chữ thường thì chỉ cần đổi lại font. 

Còn nếu khi bạn gõ tiếng anh, pháp mà không dùng mấy cái font việt đó thì làm thế nào. Rất đơn 
giản chỉ cần vài thao tác: chọn đoạn văn bản bằng cách bôi đen và nhấn giữ phím SHIFT + nhấn 
F3 đồng thời "hô biến" là bạn đã có ngay đoạn văn bản cùng nội dung khác hình thức rồi đó! 
Nếu muốn nó quay trở lại chữ thường thì chỉ cần ấn thêm một lần nữa là ok ! 

16.  Muốn mở nhiều file cùng một thao tác 
Mỗi lần mở một file bạn phải trải qua một số thao tác: 

Open --> hiện cửa sổ open; 

Select file --> chọn file cần mở; 

Đồng ý --> sẽ mở file đã chọn; 

nếu tiếp tục mở file thứ hai lại phải quay lại từng đấy thao tác ư? Không nên làm như vậy: chậm 
--> ảnh hưởng đến tài nguyên của bạn (thời gian) vả lại không chuyên nghiệp. 

mẹo: bạn chọn OPEN --> hiện lên cửa sổ OPEN. Tiếp đó nhấn giữ SHIFT và chọn số lượng file 
thoải mái. Cuối cùng là nhấn OK. Vậy là bạn đã mở được nhiều file với chỉ một hành trình rồi đó 

17.  Quay trở lại điểm xử lý cuối cùng 
Giả sử bạn làm việc với một văn bản dài (có tới vài chục trang chẳng hạn). Khi bản di chuyển 
đến một vị trí khác để thực hiện một công việc khác và ngay sau đó bạn muốn quay trở lại điểm 
làm việc trước đó. Thay vì lật từng trang để tìm lại đoạn văn bản đó hãy nhấn tổ hợp phím 
SHIFT + F5.  

Mình rất khoái cái chức năng này. Nếu không có nó thì mỗi lần ngồi dò tìm lại cũng hết hơi. Có 
lẽ do tính mình hay đãng trí !!! 
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18.  Chuyển trang nhanh trong word 
Thông thường để chuyển nhanh đến một trang nào đó thì chúng ta dùng chức năng Go to page. 
Để thực hiện chức năng này đòi hỏi bạn dạo qua hàng thực đơn (menu) gồm: Edit / Go to/ Page. 
Đi dạo với người yêu thì ai cũng thích chứ đi dạo với bàn phím hay con chuột máy tính thì cũng 
chẳng máy ai hào hứng.  

Nếu bạn dùng Windows - English version thì chỉ cần nhấn tổ hợp phím Ctrl + G là chỉ trong 
nháy mắt cửa sổ Go to page hiện ra và chỉ cần một thao tác gõ số trang cần đến là OK. Tuy nhiên 
mình có gặp phải một vấn đề là khi nhấn Ctrl + G thì nó không hiện cửa sổ đó mà lại thực hiện 
chức năng "tô đậm chữ" (Bold : Ctrl + B) ấy. Thực ra cái phím gõ tắt này có thể định nghĩa theo 
người dùng nhưng không nhẽ đi một vòng quanh thế giới để sửa lại cái định nghĩa này cho hợp 
với mình??? 

Khó ló cái ranh. Loay hoay một hồi thì cũng tìm ra được một cách khác. Hóa ra chỉ cần click hai 
nhát vào số trang trên thanh trạng thái (status bar) nằm ở phía dưới cửa sổ của Word thế là cửa sổ 
Go to page ngoan ngoãn hiện ra. Không tin bạn cứ thử xem sao ? 

19.  Chức năng zoom in/out với chuột có chức năng lật trang 
Nếu bạn đang xử lý văn bản trong word và con chuột của bạn có chức năng lật trang. Muốn 
zoom in/out để view hay quản lý văn bản của bạn, thay vì chọn phần trăm kích thước trên box 
zoom thì bạn có thể thao tác nhanh bằng cách: 

Nhấn giữ Ctrl và lăn con lăn lật trang của chuột. Hiệu quả và chuyên nghiệp - bạn thử xem 

20.  Chữa lỗi cách trong word. 
Khi thao tác word sử dụng chế độ Unicode, bạn thường gặp một rắc rối là: các âm trong từ bị 
cách nhau, hay còn gọi là lỗi “Smart cut and past”. Bạn sẽ mất nhiều thời gian để nối lại các từ 
lỗi này. Khi gặp hiện tượng này, bạn nên áp dụng phương pháp sau: Trước tiên bạn vào mục 
Tools, chọn Options. Sau khi chọn Options sẽ hiển thị ra cửa sổ như dưới đây:  

Tiếp theo, bạn vào tab Edit trong cửa sổ Options và bỏ dấu tích ở trong mục “Smart cut and 
paste” đi. Cuối cùng, nhấn nút OK để kết thúc thao tác. 

21.  Copy văn bản và ảnh nhanh từ mạng vào word. 
Lướt Web và lấy dữ liệu từ mạng về đã trở thành công việc quen thuộc của mỗi cư dân trên 
mạng. Tuy nhiên, nếu chỉ sử dụng cáp copy văn bản và hình ảnh thông thường về Word thì việc 
làm này tương đối mất nhiều thời gian, trong nhiều trường hợp, nếu dữ liệu lớn, máy tính của 
bạn có thể bị treo. Để rút ngắn thời gian, bạn nên thực hiện các bước sau: Trước hết bạn copy 
văn bản hoặc ảnh từ trên mạng, sau đó mở một trang Word mới. Tại trang này, vào mục Edit, 
chọn Past Special. Nếu dữ liệu cần copy là dạng text bạn vào mục Past Special, chọn mục 
“Unformatted Text” hoặc “Formatted Text” hoặc “Unformatted Unicode Text”. Ngược lại, khi 
dữ liệu cần copy là dạng ảnh bạn vào Paste Special, chọn mục “Device Independent Bitmap” để 
tăng tốc độ copy ảnh cũng như giảm dung lượng của file.. 
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22.  Bảo mật thông tin trong Word. 
Đôi khi, bạn muốn lưu một số thông tin riêng của mình tại máy tính cơ quan mà không muốn ai 
đọc được. File word này của bạn có thể được bảo mật cao và không ai có truy cập vào được nếu 
như bạn chọn công cụ sau. Bạn nvào mục Tools \ Options\ Security. 

Trong mục chọn mật khẩu đở mở file “Password to Open” bạn nhận mật khẩu tuỳ chọn. Bạn có 
thể chọn kiểu chữ nhập vào ô “Password to Open” bằng cách nhấn chuột vào nút “Advanced” và 
tiến hành chọn kiểu chữ thích hợp. Sau đó, bạn chuyển đến mục mật khẩu dùng để sửa đổi văn 
bản “Password to modify” bạn nhập mẩu khẩu vào. Cuối cùng bạn nhấn nút OK để kết thúc. 

Ngoài ra để có thêm tính năng bảo mật văn bạn, bạn vào Tools \ Protect Document. Tại cửa sổ 
Protect Document bạn sẽ thấy 3 lựa chọn. Track changes (ngăn không cho thay đổi Track 
Changes, mọi thay đổi sẽ được lưu lại và Track Changes sẽ bị vô hiệu hoá), Comment (cho phép 
người đọc đóng góp ý kiến nhưng không có quyền thay đổi văn bản) và Form (chỉ cho phép thay 
đổi những văn bản không được bảo vệ trong Form). 

23.   Format chữ trong AutoCorrect:  
AutoCorrect là một chức năng tuyệt vời giúp tiết kiệm "sức lao động" bằng cách tự động thay thế 
từ hoặc cụm từ sau khi bạn nhập vài ký tự đại diện. Ngoài ra, nó còn giúp sửa những lỗi chính tả 
thường gặp. Thực tế, AutoCorrect còn có thể làm được nhiều hơn thế.  

Với sự "hào hiệp" của mình, AutoCorrect cho phép thay thế dãy ký tự đã được format - in 
nghiêng, đậm, chọn font, màu sắc... Chức năng này thật tiện lợi khi soạn các văn bản đặc biệt 
như bảng báo giá có logo của công ty, giấy mời... Trước tiên, bạn format cụm từ cần thay thế, 
bôi đen rồi vào menu Tools > AutoCorrect Options > thẻ AutoCorrect > chọn Replace text as 
you type.  

Trong phần Replace, bạn nhập những ký tự đại diện như bình thường. Đừng quên kiểm tra phần 
chữ bên tay phải đã được format theo ý muốn chưa. Trong trường hợp AutoCorrect quên không 
format thì bạn vẫn có thể khắc phục bằng cách click chọn Formatted text ở phần With trước khi 
nhấn nút Add. Giờ thì mọi chuyện đã ổn, click lên OK để quay trở lại văn bản đang soạn thảo.  

24.  Phím tắt để gạch chân  
Nếu Ctrl + U (Underline) giúp bạn nhanh chóng gạch dưới chữ thì tổ hợp phím Ctrl + Shift + W 
sẽ đem đến một "thể loại" gạch chân mới. Thay vì gạch một đường thẳng liên tục dưới cụm từ, 
giờ đây, gạch ngang sẽ xuất hiện dưới từng chữ. Sự khác biệt nằm ở đây!  

25.  Format toàn văn bản  
Mỗi lần thay đổi chế độ format của một đoạn văn bản bằng chức năng Styles and Formatting, 
bạn thường bực bội vì buộc phải chỉnh sửa lại toàn bộ văn bản. Có rất nhiều giải pháp nhưng để 
tiết kiệm tối đa thời gian, bạn nên sử dụng đến thủ thuật sau: Sau khi chọn đoạn văn bản cần 
format, vào menu Format > Styles and Formatting. Khi cửa sổ Styles and Formatting xuất hiện, 
click chuột phải lên tên style > chọn Modify.  

Trong cửa sổ Modify Style, bạn đánh dấu chọn Automatically Update rồi click OK để lưu lại 
thay đổi. Thủ thuật sẽ giúp ích cho những ai thường dùng vài style nhất định khi soạn thảo văn 
bản. Vì từ "giây phút định mệnh" này, khi chế độ format được chọn cho một đoạn văn bản, 
"phần còn lại của thế giới" cũng sẽ thay đổi theo.  
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26.  Tạo lập template yêu thích  
Bạn thường xuyên dùng một số template từ "kho" cung cấp sẵn của Word. Và lần nào sử dụng, 
bạn cũng đều lặp đi lặp lại việc chỉnh sửa nó theo ý riêng của mình. Vậy tại sao bạn không "hô 
biến" template theo ý thích rồi lưu thành "của riêng"? Đầu tiên, bạn mở cửa sổ Templates bằng 
cách vào menu File > New, chọn General Templates. Khi cửa sổ Templates xuất hiện, bạn chọn 
template yêu thích rồi di chuột xuống phần Create New, click chọn Template trước khi nhấn OK.  

Lúc này, Word sẽ quay về cửa sổ soạn thảo với template được mở sẵn. Giờ thì bạn được thỏa sức 
chỉnh sửa template theo ý muốn. Sau khi hoàn tất công việc "sáng tạo", bạn click Save as rồi đặt 
tên mới cho template. Nếu chú ý, bạn sẽ thấy Word đã thiết lập sẵn định dạng và đường dẫn để 
lưu file. Lần sau, khi cần dùng đến nó, bạn chỉ việc vào thẻ General trong cửa sổ Templates. 

27.  Phím Tắt trong MICROSOFT WORD 
Sử dụng phím tắt làm cho tốc độ xử lý văn bản đem lại hiệu quả và rất nhanh chóng trong việc 
soạn thảo văn bản. Sau đây tôi xin giới thiệu về một số phím tắt thường xuyên sử dụng trong MS 
Word bằng tiếng Việt. 

Tạo mới, chỉnh sửa, lưu văn bản  

Ctrl + N tạo mới một tài liệu  
Ctrl + O mở tài liệu  
Ctrl + S Lưu tài liệu  
Ctrl + C sao chép văn bản  
Ctrl + X cắt nội dung đang chọn  
Ctrl + V dán văn bản 
Ctrl + F bật hộp thoại tìm kiếm  
Ctrl + H bật hộp thoại thay thế 
Ctrl + P Bật hộp thoại in ấn 
Ctrl + Z hoàn trả tình trạng của văn bản trước khi thực hiện lệnh cuối cùng  
Ctrl + Y phục hội hiện trạng của văn bản trước khi thực hiện lệnh Ctrl + Z  
Ctrl + F4, Ctrl + W, Alt + F4 đóng văn bản, đóng cửa sổ Ms Word 

Định dạng 

Ctrl + B Định dạng in đậm 
Ctrl + D Mở hộp thoại định dạng font chữ 
Ctrl + I Định dạng in nghiêng. 
Ctrl + U Định dạng gạch chân 

Canh lề đoạn văn bản: 

Ctrl + E Canh giữa đoạn văn bản đang chọn  
Ctrl + J Canh đều đoạn văn bản đang chọn  
Ctrl + L Canh trái đoạnvăn bản đang chọn  
Ctrl + R Canh phải đoạn văn bản đang chọn  
Ctrl + M Định dạng thụt đầu dòng đoạn văn bản  
Ctrl + Shift + M Xóa định dạng thụt đầu dòng  
Ctrl + T Thụt dòng thứ 2 trở đi của đoạn văn bản 
Ctrl + Shift + T Xóa định dạng thụt dòng thứ 2 trở đi của đoạn văn bản  
Ctrl + Q Xóa định dạng canh lề đoạn văn bản 

Tạo chỉ số trên, chỉ số dưới. 

Ctrl + Shift + = Tạo chỉ số trên. Ví dụ m3 
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Ctrl + = Tạo chỉ số dưới. Ví dụ H2O. 
Chọn văn bản hoặc 1 đối tượng 

Shift + --> chọn một ký tự phía sau  
Shift + <-- chọn một ký tự phía trước  
Ctrl + Shift + --> chọn một từ phía sau  
Ctrl + Shift + <-- chọn một từ phía trước  
Shift + ¬ chọn một hàng phía trên  
Shift + (mủi tên xuống) chọn một hàng phía dưới  
Ctrl + A chọn tất cả đối tượng, văn bản, slide tùy vị trí con trỏ đang đứng 

Xóa văn bản hoặc các đối tượng. 

Backspace (-->) xóa một ký tự phía trước. 
Delete xóa một ký tự phía sau con trỏ hoặc các đối tượng đang chọn. 
Ctrl + Backspace (<--) xóa một từ phía trước. 
Ctrl + Delete xóa một từ phía sau. 

Di chuyển 

Ctrl + Mũi tên Di chuyển qua 1 ký tự 
Ctrl + Home Về đầu văn bản 
Ctrl + End Về vị trí cuối cùng trong văn bản 
Ctrl + Shift + Home Chọn từ vị trí hiện tại đến đầu văn bản. 
Ctrl + Shift + End Chọn từ vị trí hiện tại đến cuối văn bản 

Sao chép định dạng 

Ctrl + Shift + C Sao chép định dạng vùng dữ liệu đang có định dạng cần sao chép. 
Ctrl + Shift + V Dán định định dạng đã sao chép vào vùng dữ liệu đang chọn. 

Menu & Toolbars. 

Tab di chuyển đến mục chọn, nhóm chọn tiếp theo  
Shift + Tab di chuyển đến mục chọn, nhóm chọn phía trước  
Ctrl + Tab di chuyển qua thẻ tiếp theo trong hộp thoại  
Shift + Tab di chuyển tới thẻ phía trước trong hộp thoại  
Alt + Ký tự gạch chân chọn hoặc bỏ chọn mục chọn đó  
Alt + Mũi tên xuống hiển thị danh sách của danh sách sổ  
Enter chọn 1 giá trị trong danh sách sổ  
ESC tắt nội dung của danh sách sổ 

Làm việc với bảng biểu: 

Tab di chuyển tới và chọn nội dung của ô kế tiếp. Hoặc tạo 1 dòng mới nếu đang đứng ở 
ô cuối cùng của bảng  
Shift + Tab di chuyển tới và chọn nội dung của ô liền kế trước nó  
Nhấn giữ phím Shift + các phím mũi tên để chọn nội dung của các ô  
Ctrl + Shift + F8 + Các phím mũi tên mở rộng vùng chọn theo từng khối  
Shift + F8 giảm kích thước vùng chọn theo từng khối  
Ctrl + 5 (khi đèn Num Lock tắt) chọn nội dung cho toàn bộ bảng  
Alt + Home về ô đầu tiên của dòng hiện tại  
Alt + End về ô cuối cùng của dòng hiện tại  
Alt + Page up về ô đầu tiên của cột  
Alt + Page down về ô cuối cùng của cột  
Mũi tên lên Lên trên một dòng  
Mũi tên xuống xuống dưới một dòng 

Các phím F: 
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F1 trợ giúp  
F2 di chuyển văn bản hoặc hình ảnh. (Chọn hình ảnh, nhấn F2, kích chuột vào nơi đến, 
nhấn Enter  
F3 chèn chữ tự động (tương ứng với menu Insert - AutoText) 
F4 lặp lại hành động gần nhất  
F5 thực hiện lệnh Goto (tương ứng với menu Edit - Goto)  
F6 di chuyển đến panel hoặc frame kế tiếp  
F7 thực hiện lệnh kiểm tra chính tả (tương ứng menu Tools - Spellings and Grammars)  
F8 mở rộng vùng chọn  
F9 cập nhật cho những trường đang chọn  
F10 kích hoạt thanh thực đơn lệnh  
F11 di chuyển đến trường kế tiếp  
F12 thực hiện lệnh lưu với tên khác (tương ứng menu File - Save As...) 

Kết hợp Shift + các phím F: 

Shift + F1 hiển thị con trỏ trợ giúp trực tiếp trên các đối tượng  
Shift + F2 sao chép nhanh văn bản  
Shift + F3 chuyển đổi kiểu ký tự hoa - thường  
Shift + F4 lặp lại hành động của lệnh Find, Goto  
Shift + F5 di chuyển đến vị trí có sự thay đổi mới nhất trong văn bản  
Shift + F6 di chuyển đến panel hoặc frame liền kề phía trước  
Shift + F7 thực hiện lệnh tìm từ đồng nghĩa (tương ứng menu Tools - Thesaurus).  
Shift + F8 rút gọn vùng chọn  
Shift + F9 chuyển đổi qua lại giữ đoạn mã và kết quả của một trường trong văn bản.  
Shift + F10 hiển thị thực đơn ngữ cảnh (tương ứng với kích phải trên các đối tượng trong 
văn bản)  
Shift + F11 di chuyển đến trường liền kề phía trước.  
Shift + F12 thực hiện lệnh lưu tài liệu (tương ứng với File - Save hoặc tổ hợp Ctrl + S) 

Kết hợp Ctrl + các phím F: 

Ctrl + F2 thực hiện lệnh xem trước khi in (tương ứng File - Print Preview).  
Ctrl + F3 cắt một Spike  
Ctrl + F4 đóng cửa sổ văn bản (không làm đóng cửa sổ Ms Word).  
Ctrl + F5 phục hồi kích cỡ của cửa sổ văn bản  
Ctrl + F6 di chuyển đến cửa sổ văn bản kế tiếp.  
Ctrl + F7 thực hiện lệnh di chuyển trên menu hệ thống.  
Ctrl + F8 thực hiện lệnh thay đổi kích thước cửa sổ trên menu hệ thống.  
Ctrl + F9 chèn thêm một trường trống.  
Ctrl + F10 phóng to cửa sổ văn bản.  
Ctrl + F11 khóa một trường. 
Ctrl + F12 thực hiện lệnh mở văn bản (tương ứng File - Open hoặc tổ hợp Ctrl + O). 

Kết hợp Ctrl + Shift + các phím F: 

Ctrl + Shift +F3 chèn nội dung cho Spike.  
Ctrl + Shift + F5 chỉnh sửa một đánh dấu (bookmark)  
Ctrl + Shift + F6 di chuyển đến cửa sổ văn bản phía trước.  
Ctrl + Shift + F7 cập nhật văn bản từ những tài liệu nguồn đã liên kết (chẵng hạn như văn 
bản nguồn trong trộn thư).  
Ctrl + Shift + F8 mở rộng vùng chọn và khối.  
Ctrl + Shift + F9 ngắt liên kết đến một trường.  
Ctrl + Shift + F10 kích hoạt thanh thước kẻ.  
Ctrl + Shift + F11 mở khóa một trường  
Ctrl + Shift + F12 thực hiện lệnh in (tương ứng File - Print hoặc tổ hợp phím Ctrl + P). 



Page 12 of 14 

Kết hợp Alt + các phím F 

Alt + F1 di chuyển đến trường kế tiếp.  
Alt + F3 tạo một từ tự động cho từ đang chọn.  
Alt + F4 thoát khỏi Ms Word.  
Alt + F5 phục hồi kích cỡ cửa sổ.  
Alt + F7 tìm những lỗi chính tả và ngữ pháp tiếp theo trong văn bản.  
Alt + F8 chạy một marco. 
Alt + F9 chuyển đổi giữa mã lệnh và kết quả của tất cả các trường. 
Alt + F10 phóng to cửa sổ của Ms Word.  
Alt + F11 hiển thị cửa sổ lệnh Visual Basic. 

Kết hợp Alt + Shift + các phím F 

Alt + Shift + F1 di chuyển đến trường phía trước. 
Alt + Shift + F2 thực hiện lệnh lưu văn bản (tương ứng Ctrl + S). 
Alt + Shift + F9 chạy lệnh GotoButton hoặc MarcoButton từ kết quả của những trường 
trong văn bản. 
Alt + Shift + F11 hiển thị mã lệnh. 

Kết hợp Alt + Ctrl + các phím F 
Ctrl + Alt + F1 hiển thị thông tin hệ thống. 
Ctrl + Alt + F2 thực hiện lệnh mở văn bản (tương ứng Ctrl + O) 
 

28. Hướng dẫn chuyển đổi font chữ   

Đôi khi trong công việc văn phòng, chúng ta cần chuyển đổi một đoạn hoặc một văn bản 
qua lại giữa các font thuộc các bảng mã khác nhau. Có một cách chuyển đổi rất nhanh là 
dùng công cụ đi kèm theo các bộ gõ như Unikey hay Vietkey, thế nhưng không có nhiều 
người biết được công cụ này. Trong bài viết này mình sẽ hướng dẫn các bạn cách chuyển 
đổi font với công cụ của Unikey. 

Hãy làm theo các bước sau nhé. 

Bước 1: Đánh dấu (bôi đen) đoạn văn bản cần chuyển đổi font. 

Bước 2: Sao chép (copy) đoạn văn bản vừa đánh dấu. Nhấp chuột phải vào đoạn văn bản đó và 
chọn Copy hoặc dùng tổ hợp phím CTRL + C. 

 

Bước 3: Chạy công cụ chuyển đổi font của Unikey bằng tổ hợp phím CTRL + SHIFT + F6. 
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Bước 4: Lúc này sẽ hiển thị ra một hộp thoại Công cụ chuyển đổi font là Unikey Toolkit. 

• Ở phần Nguồn, các bạn chọn Bảng mã font gốc của đoạn văn bản cần chuyển đổi. 
• Ở phần Đích, các bạn chọn Bảng mã font cần chuyển. 
• Có một số tùy chọn bên phải để các bạn tùy chỉnh. 

* Lưu ý: 

• Những font bắt đầu bằng .Vn thì có bảng mã là TCVN3 
• Những font bắt đầu bằng VNI thì có bảng mã là VNI Windows 
• Những font như Times New Roman hay Arial thì có bảng mã là Unicode 
• Ngoài ra còn có một số bảng mã khác nhưng không thông dụng bằng 3 bảng mã trên. 
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Bước 5: Sau khi đã chọn xong các thông số cần thiết thì bấm vào nút Chuyển mã và chờ quá 
trình chuyển đổi Bảng mã font hoàn tất. 

Bước 6: Bấm OK để hoàn tất quá trình. 

Bước 7: Bấm nút Đóng để kết thúc Công cụ Unikey Toolkit. 

Bước 8: Mở một trang soạn thảo mới và dán (paste) đoạn văn bản vừa chuyển bảng mã font vào 
đó. Có thể dùng tổ hợp phím tắt là CTRL + V. 

Lúc này bạn đã có một đoạn văn bản mới với Bảng mã font phù hợp với mục đích công việc. 


